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~An Introduction to 
---1------+ ______ The Music Studio 

Features of The Music Studio 
The Music Studio is your fast, fun, and creative way to compose, edit, or
chestrate, record, and play music. 

Using its powerful tools, you select instrumentation and place notes on 
the staff to compose a tune. Then, change instruments, alter their sounds, 
speed up or slow down the tempo, change keys, and play back what 
you've written-even add lyrics to your work. When you've finished, 
save it to recall anytime. 

The Music Studio offers a number of features for composing and playing 
back your musical compositions: 

• Use standard musical notation: notes, rests, key and time signatures, ac
cidentals, repeats, and more. 

• Work with the mouse, using intuitive "point and click" tools. 

• Edit musical scores easily: move, repeat, or copy sections of a song, and 
transpose passages up or down. 

• Orchestrate songs using a number of instrument voices. 

• Enter notes and chords with a mouse or with real-time recording-
directly from your MIDI-equipped instrument. 

• Play songs through MIDI-compatible instruments. 

• Save and play back your songs at any time. 

• Add up to three verses of lyrics to your songs. 

• Edit or design instruments with a professional-style waveform editor. 

• Multi-track feature lets you isolate parts of a song: harmony, melody, 
rhythm. 

1 
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"A Guided Tour of The Music Studio" takes you through all the basic 
features. It makes stops along the way for you to experiment with the pro
gram and get a feel for how it works. 

The "Reference Section" covers every aspect of The Music Studio not 
covered in the guided tour. The "Reference Section" is organized by the 
way things appear on the screen: work area, composition tools, playback 
tools, and accessory menus are covered in turn. 

This manual doesn't try to teach you about music or composition. But you 
can learn a lot just by following the guided tour from start to finish. 

Before Starting 
Make sure you have: 

The Program and Additional Songs 
and Instruments Disks 

The Music Studio "Program" disk contains the program. The "Additional 
Songs and Instruments" disk includes sample songs and sound files con
taining alternate instrumentation for The Music Studio; some of the songs 
are specifically mixed for the Casio CZ-IOI, CZ-230S, and HT -700 synthe
sizers. 

A Blank Disk 

To save your songs and sound files, you need a blank, formatted disk. 

The MIDI Connection 

If you're using a MIDI-compatible instrument with The Music Studio, you 
need a MIDI interface adapter. Follow the interface manufacturer's in
structions for connecting the computer and the instrument. 

The Music Studio supports real-time MIDI input with Macintosh™ MIDI 
interfaces and MIDI output only with the Passport® Apple IIGS MIDI card. 

Note that you must connect the interface before starting The Music Studio; 
otherwise, the program won't recognize the MIDI interface. 
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Throughout this manual, the Casio CZ-230S Synthesizer is referred to 
when discussing MIDI features. Because MIDI is an industry standard, the 
basic techniques described are the same for any MIDI-equipped instru
ment. 

Using the Mouse 
To use the mouse with The Music Studio tools, first move it so that the tip 
of the pointer is on the tool or area of the screen mentioned in the instruc
tions. Then, you can perform one of these actions: 

Click-Push and release the mouse button. 

Double-elick-Quickly push and release the mouse button twice. 

Press-Push and hold the mouse button. 

Drag - Push and hold, then move the mouse right and left or up and 
down, depending on the tool you're pointing to. 

A Note on Type Styles 
In this guide, boldface type is used for words and messages that appear 
on the screen. Boldface is also used for words you're supposed to type or 
keys you're supposed to press. For example, 

Press Return 

means that you're to press the key that has the word Return printed on it. 

A Note to the Adventuresome 
If you prefer to explore The Music Studio on your own instead of through 
the guided tour offered in the first six chapters, there's no reason not to. 
The Music Studio is simple and straightforward and works the way you'd 
expect it to. And you can always turn to any chapter of the guided tour for 
details on a specific operation. 

For additional help, the "Reference Section" (pages 33-62) explains items 
on The Music Studio tools and menus not covered in the guided tour. The 
table of contents for the "Reference Section" starts on page 33. 
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Chapter 1 

A Look Around The Music Studio 
Starting The Music Studio 
Start The Music Studio with the computer switched off. 

1. Switch on the monitor. 

2. If you want to use your MIDI interface with The Music Studio, be sure it 
is connected. 

3. Insert The Music Studio "Program" disk in the disk drive. 

4. Switch on the computer. 

5. To begin working with The Music Studio, wait for the theme music to 
finish, or press the mouse button as it plays. 

The Music Studio Screen 

The Music Studio screen provides a musical staff where you create songs, 
and a collection of tools for composing, editing, playing, and saving songs. 

5 
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You compose songs in the work area. Along the top and bottom borders 
of the work area are selectors- words or symbols that you use to select 
The Music Studio's tools. 

The tools themselves are divided into three categories-composition and 
editing tools, playback tools, and accessories. Most tools are hidden in 
menus-lists of selections that drop down or pop up into the work area 
when you point to a selector and press the mouse button. 

The Work Area 
In the middle of the work area is the grand staff, made of the upper staff 
(treble clef) and the lower staff (bass clef). 

To create a song, select a note duration from the notes menu and an in
strument from the voice palette. Then, place notes by positioning the 
pointer on the staff and clicking the mouse button. 

Note that if you have a Macintosh MIDI interface, you can also place notes 
on the staff directly from a MIDI-compatible instrument. See Chapter 4, 
"MIDI Mastery," for details. 

Composition and Editing Tools 
The composition and editing tools use standard notation, so they should 
be readily familiar to anyone with some musical background. If you don't 

Voice Palette Emphasis (Dot) Note Message Box Rest Accidentals 

Tie/Measure 

Song Scroll 
Bar 
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know all of them, just follow along on this tour-most are covered in the 
next few chapters. 

Tie/Measure. Used to connect notes or mark measures. 

Voice Palette. Lets you select one of several instrumental voices for the 
notes of your song. 

Emphasis (Dot). Used to dot, accent, or triplet notes. 

Note. Provides a menu of notes of any duration, from whole notes to 
thirty-second notes. 

Message Box. Shows the value of the note or rest selected, and describes 
the tool you're using. As you place notes on the staff, it shows their position. 

Rest. Provides a menu of musical pauses of any duration, from whole 
rests to thirty-second rests. 

Accidentals. Lets you select sharps, flats, or naturals. 

Block Actions. Affects an entire song or a selected portion: move, copy, 
repeat, transpose, change instruments, and perform other major changes 
using the choices from the menu. 

Key Signature. Sets the key for your songs. 

Time Signature. Sets the time signature for your songs. 

Song Scroll Bar. Makes it easy to move back and forth in your song. 

Tempo. Sets the tempo, from slow (56) to fast (200). 

Volume. Sets the playback volume, from soft (PP) to loud iff). 

Trash. Click twice to erase a whole song or a highlighted section. 

Playback Tools 

The playback tools let you hear your composition as you work on it, and 
let you play it once you've finished. 

~
~ Ear/Flying Note. Play an entire song or a highlighted section. 

l' 't The "flying note" plays your song starting with the notes in the 
J left column on the screen, and scrolls through the notes as it 

plays. 

7 
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Accessories Menu 
Across the top of the screen is the accessories menu, offering four selec
tions. Each accessory displays a drop-down window or menu when you 
point to it and press the mouse button. 

I_ file Goodies Options Sounds 

Apple. Gives information about The Music Studio program. 

File. Lets you save and load songs on disk, print a song, use the Jukebox, 
or leave The Music Studio. 

Goodies. Used to select the musical Paintbox, design instruments, record 
with your MIDI-compatible instrument, and more. 

Options. Used to turn features on and off: lyrics, MIDI and Apple IIGS 

voices, measure numbers, multi-track recording, and more. 

Sounds. Used to get new voice palette instruments from a disk, and save 
voices you create on disk. 
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Playing and Painting Songs 
Playa Sample Song 
Before you compose your own songs, you may want to see and hear just 
how elaborate The Music Studio's compositions can be. Songs on the 
"Additional Songs and Instruments" disk offer some good examples. 

If you have a single disk drive, note that after The Music Studio program 
is loaded and the main screen appears, you may remove the "Program" 
disk and replace it with the "Additional Songs and Instruments" disk. 

1. Make sure to place the "Additional Songs and Instruments" disk into 
your disk drive (the second drive, if you have two). 

2. From The Music Studio screen, point to File and press the mouse but
ton. The song file menu drops down. 

3. Drag the highlight (the black bar) to the first selection, Open, and 
release the button. The Load Song Files window opens. 

Note: You can also open the Load Song Files window by pressing 
Command-O. That is, you can hold down the command or Apple key 
and type the letter O. 

4. Point to the song list. Song files are those with the extension .SNG. 
There are classical pieces, rock, jazz, and country. 

The song list doesn't show all the songs on the disk at once. To see 
more songs, point to the scroll bar on the right edge of the list, then 
press the mouse button and drag it up or down. 

If you have two disk drives, be sure to click Disk first to select the 
second drive. 

S. Click the title of a song want to load: the black highlight bar appears 
over it. 

6. Click Open. The watch appears to indicate that the song is loading. 

After the song loads, the window closes, and the first measures of the 
song appear in the work area. 

9 
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7. To play, click the ear or the flying note. Stop the song at any time by 
clicking the mouse button. 

The Computerized ~1ukebox" 
You can playas many songs as you wish in a row by selecting Jukebox 
from the File menu. 

1. Point to File in the accessories menu, then press the mouse button. 
The song files menu drops down. 

2. Drag the pointer to Jukebox and release. The Jukebox window opens 
in the work area. 

(Note that if you had been working on a song, a dialog box would ap
pear to ask if you wanted to save your recent changes.) 

3. Select a song by pointing to the name in the song list and clicking. 1 
appears next to the name to indicate your first selection. 

4. To select a song not at the top of the list, drag the scroll bar at the right 
of the song list. 

5. Point to and click the other song titles to add them to your Jukebox 
play list. A number appears next to each song you select. 

6. Click Play. The song list begins to play your first selection. It plays 
through to the last selection, then repeats unless you stop play. 

7. To stop, click the mouse button. A dialog box appears with the 
message: 

Stop the music? 

Click OK to stop Jukebox play, or click Skip to jump past the current 
selection and play the next song. When you click OK, the Jukebox 
window appears on screen again. 

8. To return to the main screen, click Cancel. 

Paint a Song 
The music Paintbox gives budding musicians a way to create songs with a 
musical paintbrush and palette. Paint notes on the staff as colored blocks. 
Select wider brushes to paint longer notes. Select another color to paint 
with a different instrument. 

Once you've painted notes on screen, you can play them back using the 
ear or flying note at the lower left of the screen. 
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1. Point to Goodies in the accessories menu. Press the mouse button, 
drag the pointer to Paiq.tbox, and release the mouse button. 

The Paintbox work area appears on the screen. It's simpler than The Music 
Studio's regular work area. The grand staff is wider. You have a simpler 
set of selectors to choose from. And instead of notes and voices, you have 
a palette and a set of brushes. 

Music Studio 

2. Move the pointer down the staff. It turns into a grey block - a musical 
brush that paints the sound of grey (not ne<;:essarily a dull sound). As 
you move the brush down the treble and bass clefs, you hear it play 
the notes of the scale. 

3. Move the brush up and down the staff a few times and listen to the 
sound. 

4. Now, draw with the grey brush: try a set of blocks going up and to the 
right, beginning at the bottom of the staff. To paint each block, move 
the brush so that it's on or between the lines of the staff and click. 

5. Now, change brushes. Move the pointer to the brush selector and click 
the medium-large brush. 

6. Change musical colors by pointing to the palette and clicking light 
green. 

11 
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7. Move to the top of the upper staff and begin drawing a descending 
line. Place each block as you did in the last example. Only this time, 
place one green block for every two of the grey blocks you drew (the 
wider block plays twice as long as the narrower block). 

When you finish, you should have two lines that criss-cross. 

8. To play your musical picture, click the ear or flying note at the lower 
left of the screen. 

9. To leave the Paintbox, point to Music Studio at the top of the screen 
and click. 

You'll see the musical picture you've painted displayed in The Music 
Studio's regular work area. The blocks have been transformed into 
notes-and you've written your first song. 
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Compose It Yourself 
Now, here's how you write a song from scratch. You won't actually com
pose your own song this time; instead you'll use an old standby-"Frere 
Jacques." 

Note: Be sure you have your blank, formatted disk on hand before pro
ceeding. You'll need it to save the song you create. 

Placing Notes on the Staff 
First, make sure the staff is clear. Double-click the trash can to remove any 
notes or songs from the work area. 

1. Point to the grand staff-the pointer changes to a note. Notes sound 
as you move up and down the grand staff. 

Note Pointer ----I~ I:-+-

When you first begin The Music Studio, the note selected is a quarter note 
(a solid note with a stem). You can select a new note, with a different time 
value (duration), easily. You'll see how in just a bit. 

2. Move the pointer exactly between the two staffs in the first column 
(left side of the work area); the note pointer will have a bar through its 
middle. This bar is a Zeger line. The note on the leger line between the 
staffs is middZe-G. 

3. Click the mouse button to place the middle-Co 

4. Move the note pointer to the right of the first note and up a step. Place 
it just below the bottom line of the upper staff. Click the mouse button 
to place this D note. 

13 
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5. Again, move the note pointer to the right of the D and up, positioned 
on the bottom line of the upper staff. Click again. You've placed an E 
note. 

6. Move the note pointer to the right of the E and down two steps, to 
middle-C again. Click to place the note. The four notes (C, D, E, C) 
you've placed make up the first four-beat measure of "Frere Jacques." 

7. Click the ear to play the notes. 

Deleting and Changing Notes 

If you aCcidentally place a wrong note, simply move the note pointer over 
the note and click - the offender is removed. 

Copying Your Work 
"Frere Jacques" is made up of four repeating measures-each measure 
plays twice. The Music Studio offers a shortcut that lets you write each 
measure once, then simply copy it. 

1. Point to the bottc m of the work area, above the scroll bar and below 
the first note in your song. Boxes appear at the top and bottom of the 
work area. 

17Wl 
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2. Click the mouse. A green block marker appears in the column. 

3. Point to the bottom of the work area below the last note in your song. 
The boxes appear again. 

4. Click and the block marker expands, covering all four notes of your 
song. 

If you don't get all the notes the first time, just click at the bottom of the 
work area once to remove the block marker, then repeat the steps. 

Block Actions 

When you highlight a section of a song, you can perform a block action on 
it. To copy the measure, you select the Copy Block action. 

1. Point to the block action selector at the upper right of the screen and 
press. The block actions menu drops down. 

2. Drag the pointer down the menu. As you highlight each tool in the 
block actions menu, the name appears in the message box (to the left 
of the block action selector). 

3. When you're pointing to Copy Block, release the button. 

I~I 
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4. Point to the outside right edge of the block marker, then click. The 
block is copied. 

5. To remove the block marker, point to the bottom of the work area, 
above the scroll bar. When the boxes appear at the top and bottom of 
the work area, click once. The block marker disappears. 

6. Click the ear to hear the two measures of your song. You can also click 
the flying note to scroll the notes as the song plays. 

Saving Your Work 
As you create a song, it's a good idea to save occasionally. That way, you'll 
always have a backup in case of a mishap, or in case you make a change 
that you later decide you don't want to keep. (Use the Revert selection 
from the File menu to recall the last version of a song you saved.) 

Note: If your system has just one disk drive, you need to replace the 
"Program" disk with the disk where you'll be saving your songs. You 
may exchange disks any time after The Music Studio program is loaded 
and running. 

If your system has two drives, insert the disk for saving your song in the 
second drive. Step 3 in the following instructions tells you what to do to 
save your song on the second drive. 

1. Point to the File selector and press the mouse button. 
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2. Drag the pointer to Save As and release. The Save Song Files win
dow appears, with a list of the songs on the disk you're using. 

3. If you have two disk drives, click Drive. This changes the system to 
the second drive, where your blank formatted disk should be waiting 
to store your song. 

4. The first time you save a file, enter a name for it. Click the Save As 
box at the lower left of the window. A text cursor bar appears. 

5. Type FREREjAC.SNG, then press Return to save the file. Note that 
you need to add the extension .SNG. 

Note: Once you've saved a song, you can either click Save in the File 
menu or type Control- S to save it by the same name. Either way, a dialog 
box appears, asking if you want to replace the song. To do so, click OK. To 
halt without saving, click No. 

Changing Notes 
The next two measures of "Frere Jacques" consist of three notes; first, 
two quarter notes, then a half note. A half note plays twice as long as a 
quarter note. Like the quarter note, the half note has a stem, but the body 
of the note is open. 

[JJ Hill No« 

1. Click the note selector once to change from Copy Block to Add 
Note. 

2. Place two quarter notes, an E and an F, following the first two 
measures. 

The next note is the half note, so you need to change duration, using the 
note selector. 
3. Point to the note selector and press. Drag the pointer to the half note 

and release. A half note appears in both the note selector and the 
message box. 

4. Point to the staff. The note pointer is now a half note. Place a G note 
immediately after the F note, to complete the measure. 

d d 
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5. Copy the three-note measure you've just created. Place the block 
marker on the three notes, then use the Copy Block selection to make 
a copy of the measure just after the original. 

Be sure to hide the block marker when you've finished. 

6. Try playing your work so far; you've now completed half the song. 

Adding Dotted Notes 
The next two measures begin with a dotted eighth note: the dot indicates a 
note that plays for one-and-a-half times its normal duration. 

1. Point to the note selector and press the mouse button. Drag the 
pointer down, highlight the eighth note (the solid note with a single 
flag), and release the button. 

2. Point to the dot selector (just left of the note selector) and click. The 
note in the message box is dotted, as is the note pointer. 

3. Move the pointer to the staff. Place a G note following the last 
measure. Move the pointer over two spaces and place another dotted 
G note. 

4. Move the pointer to the dot selector and click the dot. The dot is 
removed from the note in the message box. 

5. Using the note selector, pick a sixteenth (double-flagged) note. 

[]] 
6. Point to the staff between the two G notes you just placed and place an 

A note. Point past the second G note and place an F. 
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7. Now, select a quarter note. Point to the staff and place the E and 
middle-C on the staff. 

8. Copy the measure using Copy Block. 

9. Now, on your own, add the last two measures to the song, like this: 

I 1 ~ 
j I 1 ~ 

j 
-<r- -<r-

I i 
I 

m 

The Scroll Handles 

Use the scroll handle at the right of the work area to move past the end of 
your composition . 

• Move the pointer to the right end of the staff. Blue arrows appear at the 
top and bottom . 

• Press the mouse, and the song scrolls to the end. 

Once you've completed your song, play it. Then save the file again. 
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Chapter 4 

MIDI Mastery 
Note: In these examples, we refer to the Casio CZ-230S synthesizer. 
However, MIDI is a standard interface, and most instructions apply to 
other MIDI-compatible instruments. 

Playing a song on your MIDI-compatible instrument is quite simple. You 
don't even have to write a special part for the MIDI. Any part of a song that 
would sound good played through the MIDI instrument, can be. 

In this example, you'll play "Frere Jacques" on your MIDI instrument. 

Note: Before starting, be sure that you connected the MIDI interface to 
your Apple IIGS before you started The Music Studio. If not, select Quit 
from the File menu, switch off the computer, connect the interface, and 
start again. 

Getting Ready 
First, load "Frere Jacques" (if it isn't already in your work area). If you 
haven't created this song, see Chapter 3, "Compose It Yourself." 

Setting MIDI Controls 
Now, you need to set two controls to get The Music Studio ready: MIDI 
Parameters from the Goodies menu, and Turn IIGS Off from the 
Options menu. 

The MIDI Parameters window assigns the MIDI instrument's channels 
and presets to The Music Studio's voices. 

1. Point to Goodies and press the mouse button. The Goodies menu 
drops down. Drag the highlight to MIDI Parameters and release. 
The MIDI Parameters window appears in the work area. 

Midi Parameters gives you four controls over the MIDI-equipped instru
ment. Each control has several color-coded selections. These correspond 
to The Music Studio's color-coded voices. By setting the right MIDI 
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Parameters for a particular color, you can make notes written with that 
color play through the MIDI instrument. 

2. Point to the first (grey) voice setting in the column labeled MIDI 
Channel. Press the mouse button and drag the setting up and down. 
There are 16 channels available. Set the number to 2 and release the 
button. 

3. Point to the first (grey) voice setting in the column labeled Preset. 
Press the mouse button and drag it to change the setting. The preset 
values range between 1 and 128. For the CZ-230S, set the number to 
24 and release. 

Note: The Music Studio's presets have values one greater than the value 
of Casio CZ-230S presets. For example, when you set The Music Studio's 
MIDI preset to 24, it selects voice 23-Pipe Organ 2. 
4. Point to the first voice setting (again, it's grey) in the column labeled 

Range. Press the mouse button and drag the setting up or down. The 
numbers roll through the available octave ranges. Set the range to 
36-96 (the standard range for the CZ-230S) and release the mouse 
button. 

5. Point to the column labeled Instrument, at the setting for the first 
voice, and click. Type a new name-P Organ 2-then press 
Return. 

6. Click Done. 

7. Point to Options and press. Highlight Set I1GS Off and release the 
mouse button. Then, click anywhere outside the Options menu to 
continue. 

Now that you've set these two controls, you're ready to play the song. 

Playing Through MIDI 
1. First, make sure your MIDI-compatible instrument is switched on 

and connected to your computer according to the instructions that 
came with your MIDI interface adapter. 

2. Set the MIDI channel on the MIDI-compatible instrument to 2. 

3. Check the volume control on your MIDI instrument, and you're 
ready to go. 

4. Click the ear or flying note to play the song through the MIDI
compatible instrument. 

Saving MIDI Parameters 
When you save a song or a set of sounds, the MIDI Parameters you've 
selected are saved with them. 
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New Voices 
The Music Studio lets you use a "waveform editor" to design new voices 
for the voice palette by adjusting basic sound characteristics. Before you 
begin working with voice design, here's a little background on the 
elements of sound. 

For a more detailed description of sound theory, a good place to start is 
The Science of Musical Sound by John R. Pierce (Scientific American 
Library, 1983). 

The Elements of Sound 
Two major elements contribute to the sound characteristics of an instru
ment: volume and time. The two are interrelated, and to analyze an instru
ment's sound, you need to know how its volume changes over time. For 
example, the volume of an instrument may tend to stay steady (sustain) 
over time, or it may trail off (decay). 

In the science of sound, a graph tracing the sound of an instrument as it 
changes volume over time is called the sound envelope or ADSR graph. 
ADSR stands for the four stages of the sound envelope: Attack, Decay, 
Sustain, and Release. 

Attack is the increase in volume from no sound to sound-the sound of a 
note when it first begins to play. Decay is a slight drop-off in sound 
volume that occurs in some instruments immediately after the attack. 
Sustain is an even volume level heard after the initial attack and decay. A 
wind instrument such as a trumpet has sustain as long as you blow into it. 
Finally, decay is the trailing off of the sound as the note ends; decay may 
be slow or rapid. 

Sampled Voices 
The Music Studio lets you create a unique voice for every instrument on 
the musical palette. It also lets you develop and save a limitless number of 
voice palettes in sound files. You can then use customized instruments 
with any song you write. 
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The basic voices used in the palettes are derived from digitized sample 
sounds. There are several files of wave banks-sampled sounds-on 
The Music Studio "Additional Songs and Instruments" disk; these files 
have the extension .WBNK. Each wave bank contains several sound 
samples used for the instrument voices in the palette. 

You can also read sounds from compatible Apple IIGS music programs into 
The Music Studio. 

The Design Instrument Window 
In The Music Studio, you create voices by selecting a sample voice to use, 
then setting durations and volumes for phases of the sound envelope. You 
can set as many as six points on the ADSR curve, including a sustain or 
decay point. Then, you set other characteristics such as octave range, 
vibrato, and stereo channel. 

To create an instrument, use the Design Instrument window. 

1. Point to Goodies and press the mouse button. The Goodies menu 
drops down. 

2. Drag the pointer to Design Instrument and release. The Design 
Instrument window opens. 

3. Move the pointer to the voice palette selector at the top of the screen, 
then press the mouse button. The instrument menu drops down. 

4. Move the pointer to 1 and release the mouse button. 

The Design Instrument window includes an interactive ADSR graph, or 
waveform editor, where you can look at and adjust the ADSR 
characteristics of a sound. The window also includes other tools for ad
justing and working with sounds. 
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Instrument. Click Instrument to change the instrument's name, then 
type a new name. 

Sample. Click Sample to select a digitized instrument voice to replace 
the instrument used. 

ADSR Graph shows the ADSR characteristics of a sound. Volume can be 
adjusted at up to six vertical duration bars along the graph. The number 
at the right end of the ADSR graph is the duration indicator. It displays 
the duration (in seconds) of the graph. 

Time, at the lower left of the ADSR graph, shows the duration at any place 
you point to on the graph. 

Sustain. Click to turn sustain on, then point to and click the duration bar 
that you want to represent the sustain level. The sustain duration bar is 
coded red. To remove sustain, click the Sustain button, then click the red 
duration bar previously selected for sustain. 

Release. Click to turn release on, then click the duration bar that you 
want to represent the beginning of the decay. The release duration bar is 
coded green. Remove release from the bar by clicking the Release button, 
then clicking the green bar again. 

Note that you can have either a Sustain setting or a Release setting, but not 
both. 

Stereo Channels. Click Ch to place the instrument on either the left or 
right stereo channel (if you have a stereo card installed in your Apple IIGs). 

Vibrato. Click the Vibrato button to turn on vibrato (wavering pitch). 
Drag the Depth and Speed controls to adjust vibrato. 

Octave. Drag the octave control to adjust the octave range of the sound. 
Moving to the left shifts the sound down one or more octaves; moving to 
the right shifts the sound up. 

Action. Click the four buttons to Test an instrument by playing scales, 
Copy the harmonic volumes from one point on the ADSR graph to 
another, Undo changes made to the instrument, or leave the Design In
strument window by clicking Done. 

Look at and Listen to a Sound 
Take a close look at the ADSR curve and other characteristics of The Music 
Studio's piano sound. 
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To see the ADSR graph for the piano, be sure you've selected instrument 1 
(Piano) from the voice palette selector. Notice that the piano's ADSR 
graph has a fast attack, a slow decay, and a long release. 

To hear the sound of the piano, point to the Test selector at the lower right 
of the Design Instrument window and click. A scale begins playing; it 
plays up and down repeatedly until you click again. 

To change the duration of notes played by Test, point to the note selector, 
press the button, drag the pointer to a different note, and release. Then, 
try Test again. 

Try Some Other Voices 
Now, take a look at and listen to some of the different voices available in 
your musical palette. 

1. Move the pointer to the voice palette at the upper left of the work 
area. 

2. Drag the pointer down the list of instruments. Select 9, Vibes. This 
gets the ADSR graph and other settings for the voice. 

Notice that the ADSR graph for vibes is more complex than that for the 
piano. There are other changes, too: the octave setting is higher, 
vibrato is on, and the duration and speed are set. 

3. Point to Sample and press. The list of sampled sounds drops down. 
Drag the highlight down the list to select a different voice sample-Ac 
Bass or Alto Sax. Release the mouse button. 

4. Try playing the "Vibes" with one of these sampled voices, using the 
Test selector. 

5. Click Undo to return the sound to its original settings. 

Make a Sound 
Now, try making some unique instruments by adjusting settings on the 
ADSR graph. 

1. Point to the voice palette selector, then press the mouse button and 
drag the pointer to 1. Release the mouse button to recall the "piano" 
voice. 

2. Point to the ADSR graph. The pointer turns to a vertical bar. 
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3. Point to the first duration bar on the ADSR graph (it's all the way 
against the left side of the chart). Press the mouse button. 

Notice the Time indicator below the ADSR graph: it changes to show the 
duration (in seconds) of the sound at the bar you've selected. 

4. Drag the bar to the right to stretch the duration. As you stretch it, the 
rest of the envelope compresses to make room. Notice that the Time 
indicator rolls forward to show the changing duration. Release the 
mouse button. 

5. Click Test to hear the effects of the change. The sound should be "fat-
ter," taking longer to come up to full volume. 

6. Click Undo to set the sound back to its original setting. 

Now, try setting a sustain point for the piano sound. 

7. Click Sustain at the lower right of the ADSR graph. The box is 
highlighted. 

8. Move the pointer to the second duration bar in the graph and click. 
The duration bar is now red. 

9. Point to the note selector, then press the mouse button and draghthe 
pointer to the whole note. Using a whole note makes it easier to ear 
the effect of the sustain. 

27 



The Music Studio 
1# 
~~I!J J J J IJ J J I J <) I J J rJ 

Fre-r~ J3C-qucS, Fr-cre Jac-qurs. Dor-mez-vous, dor-mez-vous? 

10. Click Test. The sound you hear is a piano, but it isn't quite a natural 
piano sound. That's because it has sustain-it stays at the same level as 
long as the note is held. 

11. Click Undo to reset the voice. 

Saving Sounds 
If you want to keep the changes you make to the voice palette, save them 
as a sound file. To do so: 

1. Make the changes that you want to make to each instrument. 

2. Select Done to leave the Design Instrument window. 

3. Point to Sounds and press. Drag the pointer to Save As and release. 

4. The Save Sound Files window appears, with a text cursor in the 
Save As: box below the sounds list. 

Note: If you have two disk drives, click the Disk box to change to the 
second drive for saving your sound file. 

S. Type a name for the sound file (you should include the extension 
. SND) and press Return. 

6. Click Done to hide the Save Sound Files window. 
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Studio Techniques 
In a multi-track recording studio, you can record the instruments in a song 
on separate tracks. Then, by playing back individual tracks, you hear the 
instruments individually. 

The Music Studio comes equipped with a built-in multi-track recorder. 
And The Music Studio multi-track lets you place any instrument on any 
track at any time. 

This is especially helpful when you want to make changes to a part of a 
song-melody, bass line, or voices that play through a MIDI-compatible 
instrument. By assigning these parts to different tracks, you can really hear 
what's going on with each of them independently . 

Tracks also offer a way to use block actions on layers of a song. For exam
ple, you can copy the rhythm section or the bass line, by turning all the 
other tracks off and using the Copy Block selection from the block ac
tions menu. You can also put one voice of a song in the trash if you need 
to, without losing the other parts. 

Turn on tbe Tracks 
To see how tracks work, let's look a song from the "Additional Songs and 
Instruments" disk, "Hotrays." This song has some interesting rhythms. 
You can use tracks to isolate them from the rest of the song and hear them 
by themselves. 

1. Make sure the" Additional Songs and Instruments" disk is in your disk 
drive. Load the song using Load Song Files from the File menu. 

2. Point to Options and press. The Options menu drops down. 

3. Drag the highlight to Use Tracks, then release. 
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The four track controls appear in the lower portion of the work area. 
These let you assign any of The Music Studio's voices to any of the four 
available tracks. 

The multi-color voice spectrum at the bottom of the work area, below the 
track controls, shows which voices are assigned to an active track. Voices 
that are switched off are indicated by white blanks in the spectrum. 

6 
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Notice that track control 1 (Tl) is highlighted-it's on. The others 
(T2-T4) are not highlighted-they are off. 

Take a look at the colored voice selector boxes next to the track control. 
These represent the voices in the palette. All voices are assigned to track 1 
at first, so the voice selectors for Tl are solid boxes. Other tracks (T2 -T4) 
have no voices assigned to them: their voice selectors are hollow boxes. 

Making Tracks 
Now, reassign the voices used in the song to different tracks. Notice that 
the opening measures of the song "Hotrays" use three voices: a grey bass 
line, a burgundy harmony line, and a violet melody line. You're going to 
assign each of these voices to a different track. 

1. Point to T 1-the control for track l. 

2. Click the burgundy box that corresponds to the harmony line. The 
box becomes hollow. 
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3. Click the violet box corresponding to the melody notes. The box 
becomes hollow. The notes of the melody disappear from the staff, 
replaced by rests. 

4. Click the flying note to play the song. The two upper voices are silent; 
you hear just the bass line. 

5. Point to T2 (track control 2) and click. This turns on track 2; the con
trol is highlighted. 
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6. Click the T2 selector box for the harmony voice (burgundy). The box 
is now filled. Notice that the notes for the harmony line appear again 
on the staff. 

7. Click the flying note again. Now you see and hear the bass and har
mony voices together, without the melody. 
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The' 'Reference Section" is organized by the way things appear 
on the screen. The work area, composition tools, playback 
tools, and accessories are illustrated and explained. Menu 
selections are listed according to the menu they appear on. 

The Music Studio Screen ................................. 35 
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The Staffs ........................................... 36 
Scroll Handles ........................................ 36 
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Current Column/Measure ............................. 36 
Last Column/Measure ................................ 37 
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Along the top and bottom borders of the work area are a number of selec
tors-words or symbols that you use to select The Music Studio's com
position and editing tools, playback tools, and accessories. Most tools are 
hidden in menus-lists of tools that pull down or pop up onto the work 
area when you point to a selector and press the mouse button. 

The Work Area 
Block Markers 

Scroll A 
Handles - ~ • / 

fll 

{ [~;=I==============~~ Upper Staff Grand Staff ~~' I Lower Staff 

Scroll --~C"~.~ ___ IIJII_MuiSl.'c.s.\UidlC:'O;=-____ D=i:l Handles 1 1 

T II I 
Current Column/Measure Song Scroll Bar Song Slider Last Column/Measure 
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In the middle of the work area is the grand staff, made of the upper staff or 
treble clef and the lower staff or bass clef. 

The staffs are where you place the notes of your composition. You can 
place up to 15 notes in a single column. 

Scroll Handles 
Invisible handles on the left and right ends of the staff let you move back 
and forth through a song. To use the scroll handles: 

• Point to the left end of the staff to move toward the beginning of a song. 

• Point to the right end of the staff to move toward the end of a song. 

Blue arrows appear above and below the staff. 

• Press the mouse button to begin scrolling. 

• Release the button to stop scrolling. 

Song Scroll Bar 
The song scroll bar at the bottom of the work area lets you move back and 
forth through the song with ease. You can move anywhere in a song simp
ly by pointing to a position on the scroll bar and clicking. 

Song Slider 

Point to and drag the song slider back and forth in the song scroll bar to 
move to any position in a song. 

Current Column/Measure 

This current column number shows the column displayed at the left end 
of the staff, or the column where the pointer is positioned on the staff. 
Click the current column number to jump to the beginning of a song. 

When you have added measure bars with the Goodies selector and turned 
measure numbers on with the Options selector, this number shows the 
current measure. 
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Last Column/Measure 

This last column number shows the last column in the song. Click the last 
column number to jump to the end of a song. 

When you have added measure bars with the Goodies selector and turned 
measure numbers on with the Options selector, this number shows the 
last measure. 

Block Selectors and Block Markers 

Block selectors are boxes used for placing the block marker. The block 
marker is a visual indicator used for block actions (see "Block Actions;' 
page 42). The block selectors appear when you move the pointer to the 
top or bottom edge of the work area. 

To mark a block: 

• Point to the top or bottom edge of the work area, just above or below 
the column where you want the block marker to begin. The block selec
tors appear at the top and bottom of the column. 

• Click the mouse to set the start of the block marker. The green block 
marker appears in the column you've selected. 

• Move to the last column you want to include in the marked block. Again, 
point to the top or bottom edge of the work area. 

• Click to mark the end column. The block marker stretches to cover the 
beginning and end columns and all columns in between. 

• After using a block action, remove the block marker by again clicking 
the upper or lower edge of the work area. 

Composition and Editing Tools 
Most of The Music Studio's selectors are used for composing and editing 
songs. 

Note that many of the composition tools can also be called by command 
key combinations. Command key combinations are listed with the tools 
they work with. 
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To type a command key combination, press and hold the ~(Ci :t)~ key 
(the Apple key), then type the other key shown. For example: 

Command-S 

means hold down the! !h;:(=Ci====:t~)~ key and type S. 

Voice Palette Emphasis (Dot) Note Message Box Rest Accidentals 

Tie/Measure 
Bar 

J' 
1 

Key Signature Time Signature Tempo 

Message Box 

Volume 

Block Actions 

The message box is actually two boxes. The small box on the left shows 
the note or rest selected (or last used). The larger box describes the tool 
you are using, and shows the position of notes as you place them on the 
staff. 

Tiel Measure Bar 
Press here for the tie/measure bar menu (or press Command-I), then 
point and release. 

Use the tie to connect notes in the same voice of the same pitch: 

• Select the tie. The pointer turns to a tie when you move to the staff. 

• To place a tie, simply touch the left end of the tie pointer to the bottom 
of the first note you want to connect, then click. 
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• Touch the right end of the tie pointer to the bottom of the second note 
you want to connect, and click again. 

• To remove a tie, position the tie pointer and repeat the process. 

Note that you can't begin or end a block marker between two tied notes. 
Note also that you can use ties only to connnect notes in the same voice of 
the same pitch. 

Use the measure bar to mark individual measures of a song: 

• Select the measure bar. The pointer turns to a measure bar when you 
move it to the staff. 

• Place the measure bar between two columns and click. 

• To remove a measure bar, place the measure bar pointer on a measure 
bar, then click. 

You can also place measure bars throughout a song automatically using In
sert Measure Bars from the Goodies menu. 

Voice Palette 
Press here for the voice palette (or press Command-2). The voice palette 
lets you pick an instrumental voice for the notes you place on the staff. 

• Drag the pointer to the voice you want to select. The names of the 
voices appear in the message box as you move through the palette. 

• Release the button. 

Note that you can load and save voice palettes using the Sounds menu. 
You can change the characteristics of the voices using Design Instru
ment from the Goodies menu. 

Emphasis (Dot) 
Press here for the emphasis menu (or press Command- 3). This menu lets 
you dot, accent, or triplet the notes you place on the staff. 

• Drag the pointer to the emphasis marker you want to use, then release. 
The emphasis marker appears on the note shown in the message box and 
is added to the notes you place on the staff. 

• To remove emphasis, click the emphasis selector. 
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Dot 

The dot plays a note for one-and-a-half times its normal value. For exam
ple, a dotted half note plays as long as a half note plus a quarter note. 

Accent 
The accent makes notes play at a slightly higher volume. Make sure the 
volume slider is set a bit below the maximum, or you won't hear the ac
cent. 

Triplets 
Triplets are placed three in a row. Three triplet notes play in the same time 
as two regular notes. 

J J 
Note that a note can't be both dotted and a triplet. 

Note 
Press here for the note menu (or press Command-4), to select a note of 
any duration, from whole notes to thirty-second notes. 

To place notes: 

• Select a duration from the note menu. 

Whole 
0 

• Point to the staff. The pointer turns to a note. 

Half j • Position the note pointer, then click. 

Quarter J 
Eighth } 

Sixteenth ) 
Thirty-Second } 
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To erase a note: 

• Position the note pointer over the note, then click. The notes can be of 
different durations, and you can also erase a note with the rest pointer. 

Rest 
Press here for the rest menu (or press Command-5), to select musical 
pauses of any duration-from whole rests to thirty-second rests. 

To place rests: 

• Drag the pointer to a duration in the rest menu. 

Whole • Point to the staff. The pointer turns to a rest. 

• Position the rest pointer, then click. 
Half 

Quarter ~ 

Eighth "I 

Sixteenth ¥ 
Thirty-Second If 

To erase a rest: 

• Position the rest pointer over the rest on the staff and click. The two 
rests can be of different durations . 

Accidentals 
Press here for the accidentals menu (or press Command-6), to select 
sharp, fiat, natural, or diatonic notes. 

An accidental is a half step change in the pitch of a note. The key signature 
determines the natural pitch of each note on the staff, based on the scale 
for the key selected. Use accidentals to place notes not on the natural scale 
of the key chosen for the song. The current key selection returns to the 
diatonic note-the natural note of the scale. 
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Current Key 
(Diatonic) 

• When you select an accidental, it appears on the 
note displayed in the message box, and applies to 
all notes placed. 

Sharp 

Flat 

Natural 

• To stop placing accidentals with notes, select cur
rent key. 

Block Actions 
Press here for the block actions menu (or press Command- 7). Block ac
tions let you change part of a composition or the entire piece. 

To change a block of a song, you must first select it with the block 
markers, using the techniques described earlier (see "Block Selectors and 
Block Markers;' page 37). 

Insert Block 

;~;I;~ Copy Block 

Move Block 

Replace Instrument 

Replace Durations 

Lengthen Durations 

Shorten Durations 

:::otJ:!:.f- Transpose Up One Step 

Transpose Down One Step 

~~~~~- Add Repeat 
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Insert Block 
Select Insert Block to add blank columns to a composition. 

To add a single blank column, simply click the column that you want to 
follow the blank. 

To add two or more blank columns: 

• Place the left end of the block marker on the column that you want to 
follow the inserted block. 

• Mark a block of columns as wide as the space you want to add. 

• Click the marked block. 

Copy Block 
Use Copy Block to copy a passage of a song to anywhere in that son~. 
Note that while other block actions affect an entire song when no block is 
marked, Copy Block works on an entire song only if you highlight the 
whole thing. 

To use Copy Block: 

• Mark a block to copy. 

• Point to the column/ollowing the place where you want the copy to go, 
then click. 

Note: You can use Repeat Block instead of Copy Block to playa passage 
or an entire song any number of times. See "Add Repeat," page 46. 

Move Block 
Use Move Block to move a passage of a song to anywhere in the song. 
Move Block works only on the highlighted section of a song. 

To use Move Block: 

• Mark a block to move. 

• Point to the column where you want the block moved, then click. 

Replace Instrument 
Use Replace Instrument to change notes from one voice to another. To 
replace an instrument: 
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• If you're changing the whole song, the program displays a dialog box: 

Alters entire song! Sure? 

• Click OK to make the change, or click No to leave the notes unchanged. 

Replace Durations 
Use Replace Durations to change all notes and rests of one duration to 
another. You can, for example, change all quarter notes and rests to 
eighths. 

• From the note selector, pick the new note duration you want to use. 

• Mark a block, or alter all the notes in the song. 

• Point to a note of the duration you want to change, then click. 

• If you're changing the whole song, the program displays a dialog box: 

Alters entire song! Sure? 

• Click OK to make the change, or click No to leave the notes unchanged. 

Lengthen Durations 
Use Lengthen Durations to double the duration of all notes and rests. 
Quarter notes become half notes, half notes become whole notes, etc. To 
lengthen durations: 

• Mark a block, or lengthen all the notes in the song. 

• Click anywhere on the marked block if you're lengthening durations 
within a block. Click anywhere on the staff if you're changing the whole 
song. 

• If you're changing the whole song, the program displays a dialog box: 

Alters entire song! Sure? 

• Click OK to make the change, or click No to leave the notes unchanged. 
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Shorten Durations 
Use Shorten Durations to cut the duration of all notes and rests in half. 
Quarter notes become eighth notes, half notes become quarter notes, etc. 
To shorten durations: 

• Mark the block, or shorten all the notes in the whole song. 

• Click the marked block if you're shortening durations within a block. 
Click anywhere on the staff if you're changing the whole song. 

• If you're changing the whole song, the program displays a dialog box: 

Alters entire song! Sure? 

• Click OK to make the change, or click No to leave the notes unchanged. 

Transpose Up One Step 
Use Transpose Up to raise all notes and rests one whole note. A becomes 
B, C-sharp becomes D-sharp, etc. To transpose up: 

• Mark a block, or transpose all the notes in the song. 

• Click the marked block if you're transposing a block. Click anywhere on 
the staff if you're changing the whole song. 

• If you're changing the whole song, the program displays a dialog box: 

Alters entire song! Sure? 

• Click OK to make the change, or click No to leave the notes unchanged. 

Note: You can also transpose a song or passage using the key signature 
selector at the lower left of the screen - see "Key Signature," page 46. 

Transpose Down One Step 
Use Transpose Down to lower all notes and rests one whole note. A 
becomes G, B-flat becomes A-flat. To transpose down: 

• Mark a block, or transpose all the notes in the song. 

• Click the marked block if you're transposing a block. Click anywhere on 
the staff if you're changing the whole song. 

• If you're changing the whole song, the program displays a dialog box: 

Alters entire song! Sure? 

• Click OK to make the change, or click No to leave the notes unchanged. 
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Note: You can also transpose a song or passage using the key signature 
selector at the lower left of the screen-see "Key Signature," page 46. 

Add Repeat 
Repeats let you playa passage or an entire song up to 127 times. You can 
repeat any number of passages within a song. 

To use repeats: 

• Mark a block, or repeat the entire song. 

• Click the marked block to repeat that block or click anywhere on the 
staff to repeat the whole song. 

• The Music Studio jumps you to the first part of the block being repeated, 
where the begin repeat marker is placed. 

• Change the number of repeats by moving the mouse up and down. Click 
to set the number. 

To erase repeats: 

Be sure Add Repeat is selected from the block actions menu. 

• Mark the repeated section of the song with the block markers (unless 
you're removing a repeat for an entire song). 

• Point to the beginning repeat marker and click. 

• Move the mouse down to set the number of repeats to 1. Click again and 
the repeat is removed. 

Key Signature 
Press the key signature selector at the lower left of the screen to select the 
key signature for a song or a portion of a song. 

To change the key for a song: 

• Press the key signature selector, then point to the new key and release. 
The New Key window appears in the work area. 

• Click Transpose to move the notes of the tune to the scale of the new 
key, or click Change to change the key of the song without moving the 
notes. 

• Click Do it to complete the key change, or click Cancel to leave the key 
as it was. 
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To change the key for a portion of the song: 

• Scroll the song so that the first column of the passage to change is at the 
left end of the staff. 

• Press the key signature selector, then drag the pointer to the new key 
and release. The New Key window appears in the work area. 

• Click Insert to add the new key signature to the column at the left of the 
staff. 

• Click Transpose to move the notes of the tune to the scale of the new 
key. If you don't click Transpose, the key of the passage changes, but 
the notes remain the same. 

• Click Do it to complete the change, or click Cancel to leave the key as it 
was. 

Time Signature 
Press the time signature selector to select the time signature for the whole 
song. 

About Time 
The time signature is made of two numbers. The upper number represents 
the beats in a measure, the lower represents the duration of a beat. For ex
ample, 4/4 (the most common time Signature) means each measure has 
four beats, and each beat is a quarter note. 6/8 means each measure has six 
beats, with one eighth note per beat. 

To change the time signature for a whole song: 

• Press the time signature selector, then point to the new time signature 
and release. 

Tempo 
To set the tempo for an entire song: 

• Drag the slider to set the tempo: 56 is slow, 200 is fast. The musical term 
for the tempo you've selected appears in the lower left of the tempo 
box. 

To set the tempo for a portion of a song: 

• Scroll through the song until the first notes that you want to change tem
po for are at the left edge of the staff. 
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• Point to the tempo adjustment control at the bottom of the screen, and 
click on the "note equals" icon. 

A new tempo indicator appears above the far-left column on the staff. 

• Drag the tempo slider back and forth to set a new tempo, then release. 
The new tempo appears in the indicator above the far-left column. 

You can place several tempo settings in a song using these same steps. Note 
that the tempo settings are saved with a song file. 

Volume 

Drag the sliding control to set the volume of playback, from soft (Pp) to 
loud iff). The two letters represent the dynamic setting and use standard 
musical notation. 

Note that the volume you set is saved with a song file. 

To set the volume for a section of a song: 

• Move the song so that the first notes of the passage you want to set a new 
volume for are at the left of the staff. 

• Click the dynamic setting iff, mp, pp, etc.) in the lower portion of the 
screen, below the song slider. A volume setting indicator appears above 
the staff, at the beginning of the passage you've changed. 

• Move the volume slider back and forth to set the volume for the passage. 

You can repeat the process to adjust the volume for other sections of the 
song. 

Trash 
• Click trash twice to erase a whole song or a marked block of a song. 

• To restore a song, click trash twice again, before you do anything else. 

Note that when you erase a marked block, it can't be restored. 

When you switch on tracks (from the Options menu) only notes assigned 
to a selected track are erased (see" Studio Techniques" in chapter 6 of the 
guided tour). Notes that are erased when the tracks are switched on can
not be restored. 
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Ear 
• Click the ear symbol to play an entire song or a highlighted block of a 

song. Click again anywhere on the screen to stop. 

Flying Note 
• Click the flying note symbol to playa song. If a block is highlighted, the 

flying note begins playing the song with the first highlighted column. If 
not, the flying note begins play with the first column at the left end of 
the staff. The song scrolls as it plays. 

• When you let the song play to the end, the program returns to the notes 
where you started. 

• If you click to stop the song, it remains on screen where you stopped it. 
This is helpful when you want to find a specific note or passage. 

The Accessories Menu 
Across the top of the screen is the accessories menu, a set of selectors of
fering a variety of tools and options that help you with your work. 

Apple 
• Press the apple symbol for copyright information about The Music 

Studio. 

The Accessory Menus 
The File, Goodies, Options, and Sounds selectors all have pull-down 
menus that appear when you point to them and press. These are used to 
select important composition, editing, and file-saving tools. Each ac
cessory menu is covered separately, in the next four sections. 
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• Press the word File at the top of the screen to get the File menu. 

From the File menu, you can select one of several file operations. 

Open 
Use this selection to open song files saved to the disk (or press Command
O). When you select Open, this window appears: 

File Path 

Song List 

Selected File 
Name 

-

{ 
-

load Song Files 

~/AUDIOlIGHT/SONGSI 

o HOTRAYS.SNG ,Q. ( 
o lOll YSCAFE.SNG 
DRAGTIME.SNG « 
DSTARSPAN.SNG 

~ ( 

iHOTRAYS.SNG I ( 

o Append o Merge 

Disk ) 

Open » 
Close ) 

Cancel ) 

File Path. Shows the disk volume and folders currently open. 

Song List. Lists the songs, wave banks, and sound files on the current disk 
and path. Drag the slider at the right of the list to scroll through the songs. 

File Name. Lists the song currently loaded or the song you've selected 
from the song list. 

Append/Merge. These let you choose to add the song you are loading to 
the song currently in the work area. Append adds the song at the end of 
the current song. Merge places the two songs together, so that both begin 
at the same point. 

Disk. Click here to change disk drives (if you have two drives) or to 
change the disk. 

Open. Lets you open a new folder or song file. 

Close. Lets you close a folder. 

Cancel. Click here to close the Load Song Files window and return to 
the work area. 
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To load a song file: 

• Drag the highlight to Open or type Command-O. The Load Song Files 
window opens. 

• To open a folder, highlight the name and click the Open button. 

• Double-click the name of the song you want to load in the song list. Or, 
click the name of the song, then click Open. 

The Load Song Files window closes, and the song appears in the work 
area. 

Save 
Once you've saved a song, you can save it again by the same name in a 
single step, without opening the Save Song Files window. To save a song 
the first time, or to save a song by a new name, see "Save As" described 
below. 

To save a song by its previous name: 

• Drag the highlight to Save and release, or press Command-So A 
message appears in the File Name bar: 

Replace (songname)? 

• Click OK to save the song. Click No to cancel without saving. 

Save As 
Use this option to save a song the first time, or to save a song by a new 
name. Use the Save selection to save a song by the same name once you 
have named it using Save as. 

When you drag the pointer to Save as and release, this window appears: 

Save Song Files 

File Path - ~/AUDIOlIGHT/SONGSI 

Free: I/BOOkb ( Disk ) 

{ 
o HOTR A YS.SNG ~ ( New FOlder) 
o lOll YSCAFE.SNG ( Open ) o RAGTlME.SNG 
o ST A RSP A N.SNG 

~ 
( Close ) 

(( » Save 

Song List 

Save As: 
( ) -HI I 

Cancel 
File Name 
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File Path. Shows the disk volume and folders currently open. 

Song List. Lists the songs on the current disk and path. Drag the slider at 
the right of the list to scroll through the songs. 

Save As. Lets you type in the name for the song, or displays the name 
previously used for the song. 

Disk. Click here to change disk drives (if you have two drives) or to 
change the disk. 

New Folder. Lets you create and open a new folder on the currently 
selected disk. To do so, simply click here, then type the name for the 
folder in the Save As box, and press Return. 

Open. Lets you open an existing folder. 

Close. Lets you close a folder. 

Save. Double-click here to save the song by its existing name. 

Cancel. Click here to close the Save Song Files window without saving 
and return to the work area. 

To save a new song: 

• Drag the pointer to Save As and release. 

• If you have two drives, click Drive to change to the second disk drive. 
Make sure a formatted disk is loaded in the drive. 

• If you have one drive, remove the "Program" disk, insert a formatted 
disk in the drive, then click Drive. 

• To place a new folder on the disk, click New Folder, then type a name 
for the folder in the Save As box, and press Return. 

• To open a folder, click the folder name on the song list, then click Open. 

• Click the Save As: box. A cursor bar appears. 

• Type a name for the song, up to 10 characters. Add the extension .SNG 
to the name and press Return. 

To save a song by a new n3llle: 

• Drag the pointer to Save As and release. 

• Press the Delete key several times to remove the previous name from 
the Save As: box. 

• Type the new name (include the extension .SNG) and press Return. 
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Keep in mind that you can't save songs on The Music Studio "Program" 
disk. Instead, you'll need to place a formatted disk with sufficient space 
for your song in the disk drive. 

Revert 
Select Revert when you want to change a song back to the version you 
last saved to disk. Revert clears any changes you've made and loads the 
song from disk. 

• Drag the pointer to Revert and release. 

• A dialog box appears: 

Discard recent changes? 

• Click OK to load the song from disk, or click Cancel to keep the song in 
the work area. 

Rename/Delete 
These choices let you change the name of any song on the disk, or delete a 
song from the disk. 

To ren3llle a song: 

• Drag the highlight to Ren3llle and release. 

• The window that appears has the same controls as the Save Song File 
window. You can change disks with Disk, and use the Open and Close 
selectors to choose a new folder. 

• On the song list, click the name of the song you want to rename. 

• Click Ren3llle. 

• A text cursor bar appears in the Save As: box. Type your new name and 
press Return. 

To delete a song from disk: 

• Drag the highlight to Delete and release. 

• The window that appears has the same controls as the Save Song File 
window. 

• Click the name of the song you want to delete in the song list. 

53 



The Music Studio 
i# 
~ Ilea J J a la 

Fre-rc Jac-ques. Fr-ere 

• A dialog box appears: 

Really delete 
(SONGNAME) 

J J J J .J 13 
lac-ques, Dor-mez-vous, dor-mez-vous? 

• Click OK to delete the file. Click No to stop without deleting. 

Jukebox 
Select Jukebox to playa selection (a play list) of your own compositions 
-or The Music Studio's prerecorded compositions-in any order you 
choose. For details on the Jukebox, see Chapter 2 of the guided tour, 
"Playing and Painting Songs." 

Print Song 
If you have a printer connected to your Apple IIGs, you can print your 
songs-words and music-using this selection from the File menu. 

• Before you print, make sure your printer is on, on-line, and loaded with 
paper. 

• Select Print Song from the File menu. The Printer Ready dialog box 
appears in the work area. 

• Check the printer, then click Ready. Click Cancel to stop without 
printing. 

Quit 
• Select Quit to leave The Music Studio program. 

• If you've made recent changes to your work, a dialog box appears: 

Discard recent changes? 

• If you don't wish to keep your changes, click OK; if you wish to save 
your song, click Cancel. 

Goodies 
The Goodies menu gives you access to a number of The Music Studio's 
auxiliary composition tools. 

54 

Reference 

1 a J J :11 
Son-nez Irs rna-tines, les rna-tines, Ding din donI Ding din donI 

Paintbox 
Paintbox provides a way for the non-musician to begin creating original 
music, by painting sounds from a musical palette on the screen. The 
Paintbox is very intuitive-and very easy to use. 

For an example of how to use the Paintbox, see Chapter 2 of the guided 
tour, "Playing and Painting Songs." 

Design Instrument 
The Design Instrument window presents a full-featured waveform 
editor and control panel for creating complex instrumental sounds. It in
cludes a graphic representation of the instrument's ADSR characteristics, 
and provides a number of controls for adjusting the properties of that in
strument. 

For step-by-step details on using Design Instrument, see Chapter 5 of 
the guided tour, "New Voices." 

MIDI Parameters Window 
MIDI Parameters let you set controls for activating the MIDI interface. 
The MIDI interface lets you play songs composed with The Music Studio 
on your MIDI-compatible instrument. For a full discussion of using the 
MIDI interface, see Chapter 4 of the guided tour, "MIDI Mastery." 

Change Song Title 
This Goodies menu selection lets you add a title to your song-a title that 
replaces Music Studio at the bottom of the work area. This title can be 
different than the name you give the song file. 

The song title is saved with the song file. Whenever you load the song into 
The Music Studio, the title appears at the bottom of the work area. 

To give a song a title: 

• Choose Change Song Title from the Goodies menu. A prompt and 
text cursor appear at the bottom of the work area. 

• Type your title, then press Return. Your title can be up to 30 characters 
long. The title is saved when you save your song. 
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Insert Measure Bars automatically adds measure bars throughout the 
song you're working on. To add measure bars, you need to first add a time 
signature to your song. 

Note that you can also place individual measure bars using the Measure 
Bar selection from the tie/measure bar menu. 

To place measure bars, first use the time signature selector to set beats per 
measure (see page 47). 

Options 
Use the Options menu to turn some of The Music Studio's features on and 
off. Some options provide two different menu selections, depending on 
their current setting; others are simply checked when they are selected. 

Add/Remove Lyrics 
You can add up to three verses of lyrics to a song using this feature. Lyrics 
are placed in the lower portion of the work area, below the bass clef. Your 
lyrics are saved when you save the song. 

Once you add lyrics, the Goodies menu changes to list Remove Lyrics. 
Selecting this item deletes the lyrics from the screen. However, they re
main on the disk file if you've saved the song. 

To add lyrics: 

• Select Add Lyrics from the Options menu. Three verse numbers appear 
at the lower left of the work area. 

• Move the song so that the notes where the lyrics should begin are at the 
left edge of the work area. 

• Point below the first note, next to the first verse number, and click. A 
text cursor appears. 

• Begin typing lyrics. 

• Use the left/right arrow keys to move back and forth through your 
lyrics. 

• Use the up/down arrow keys to move to the other verses. 

• To erase a mistake, position the cursor over it and press the Delete key. 
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• To type over a mistake, position the cursor over it and type the correc
tion. 

• To finish lyrics, simply press the mouse button or Return-your lyrics 
remain on the screen. 

• To begin typing again, click the lyric line anywhere you want to place 
lyrics. 

• You may want to add spaces between the columns of your song to ac
commodate the lyrics. To do so, use the Insert Block selection from the 
block actions menu. 

To remove lyrics: 

• From the Goodies menu, select Remove Lyrics. The lyrics are per
manently deleted from the screen. 

Use Tracks 
Like a multi-track recorder, The Music Studio lets you place voices on four 
different tracks. Use Tracks lets you hear individual voices in your songs, 
by turning them on and off independently. For a complete discussion and 
example of multi-track recording with The Music Studio, see Chapter 6 of 
the guided tour, "Studio Techniques." 

Measure Numbers Off/On 
Use this selection to show the measure numbers. To do so, first use the in
sert Measure Bars selection from the Goodies menu, or add measures 
using the tie/measure bar selector. When you set Measure Numbers On, 
the numbers appear at the end of each measure, just above and before the 
measure bar. Also, the current column/end column indicators next to the 
song scroll bar change to show the current measure/end measure. 

Flip Note 
This control inverts the stem on the note pointer and on any notes you 
place with the pointer. This is useful when you are placing any note with a 
stem (all but the whole note) high on the bass or treble clefs: inverted 
stems are standard musical notation for these positions. 
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To flip a note: 

J J IJ J j 
Jac-qUC5. Dor-mC:Z-VOU5, 

• Select a note with a stem from the notes menu. 

I J J j 
dor-mcz-vous' 

• From the Options menu, select Flip Note or press the spacebar. 

• To flip the note back, select Flip Note or press the spacebar again. 

Use 1 Instrument 
Use this feature to play your song without instrumentation. It plays your 
song as though all the notes were in the same voice. 

• Using the voice palette, select the instrument that you want to use to 
play your song. 

• From the Options menu, select Use 1 Instrument. 

• Click the ear or flying note selector to play your song. 

• To return to normal play, pull down the Options menu and select Use 1 
Instrument again. 

Turn Note Off 
Use this selection to turn the sound of the note pointer (used for placing 
notes on the staff) on and off. Select it once to turn the sound off, select it 
again to turn it on. 

Turn IIGS Off/Turn MIDI Off 
These controls select the Apple IIGS, the MIDI, or both for playing your 
songs. A check mark indicates that the setting is off; no check means the 
setting is on. Pull down the Options menu, drag the highlight to the con
trol you want to set, then release the mouse button to make the setting. 

You also need to use the MIDI Parameters window (described in chapter 
4 of the guided tour) to control MIDI playback. 

Note: If no MIDI controller is installed in your Apple IIGS, the Turn MIDI 
Off and Turn IIGS Off selections appear in grey, indicating that you can't 
select these options. 

Sounds 
This selector opens the Sounds menu. Use the Sounds menu to load alter
nate sound files from The Music Studio disk and to save sound files to your 
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song disk. You can also use the Sounds menu to save instrument voices 
you create in the Design Instrument window (see "Goodies;' above). 

The Music Studio offers a voice palette with 15 color-coded instrument 
positions. The sound file that loads with the program provides one instru
ment for each position. Note that, depending on the sound file you load, 
you may not always have 15 instruments available in the voice palette. 

Open 
Use this selection to open sound files saved to the disk. When you select 
Open, this window appears: 

Lood Sound Files 

File Path - ..511 AUDIOLIGHT ISONGSI 

{ 
o CLASS I CAL.SND ~ ( Disk ) 
D.JAZZ.SND 
DROCK.SND « Open » 
DVOICES.SND 

~ ( Close ) 

Sound List 

File Name - + I ( Concel ) 
o Cleor sound oreo before IFF lood 

File Path. Shows the disk volume and folders currently open. 

Sound List. Lists the sounds on the current disk and path. Drag the slider 
at the right of the list to scroll through the sounds. 

File Name. Lists the sound currently loaded or the sound you've selected 
from the Sound List. 

Clear sound area before IFF load. Lets you load voice samples created 
in standard interchange format. Clearing the sound area removes other 
voices before loading a new sound sample. 

Disk. Click here to change the current disk drive. If you have two drives, 
be sure to click here to change drives the first time you save a sound to 
disk. 

Open. Lets you open a new folder or sound file. 

Close. Lets you close a folder. 

Cancel. Click here to close the Load Sound Files window and return to 
the work area. 
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To load a sound me: 

• Drag the highlight to Open. The Load Sound Files window opens. 

• If you have two drives and want to load a sound from your own disk, 
use the Disk button to change disk drives. 

• Use the Open button to open a folder on the drive. 

• Double-click the name of the sound you want to load in the Sound List, 
or click the name of the sound, then click Open. 

The Load Sound Files window closes, and the sound is loaded. Using the 
voice palette now selects voices from the new sound file. 

Save 
Saves a sound previously saved to disk in a single step, without opening 
the Save Sound Files window. The first time you save a sound file, you'll 
need to use the Save As selection, described below. 

To save a sound by its previous name: 

• Drag the highlight to Save and release. A message appears in the File 
Name bar: 

Replace (soundname)? 

• Click OK to save the sound. Click No to cancel without saving. 

Save As 
Use this option to save a sound the first time, or to save a sound by a new 
name. Use the Save selection to save a sound by the same name once you 
have named it with Save As. 

When you drag the pointer to Save As and release, this window appears: 

Soye Sound Files 

File Path - ..al AUOIOLIGHT ISONGSI 
Free: ( Disk ) 

{ 
o CLASS I CAl.SNO ~ ( New Folder) 
DJAZZ.SNO ( ) o ROCK.SNO Open 

o VO I CES.SNO 

~ 
( Close ) 

«: Soye ] 

Sound List 

Soye As: o IFF 

II I ( Cancel ) 
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File Path. Shows the disk volume and folders currently open. 

Sound List. Lists the sounds on the current disk and path. Drag the slider 
at the right of the list to scroll through the sounds. 

Save As. Lets you type in the name for the sound, or displays the name 
previously used for the sound. 

IFF. Lets you save sounds in the Apple standard voice file format. 

Disk. Click here to change disk drives (if you have two drives) or to 
change the disk (if you have one drive). 

New Folder. Lets you create and open a new folder on the currently 
selected disk. To do so, simply click here, then type the name for the 
folder in the Save As box, and press Return. 

Open. Lets you open an existing folder. 

Close. Lets you close a folder. 

Save. Double-click here to save the sound by its existing name. 

Cancel. Click here to close the Save Sound Files window without saving 
the sound and return to the work area. 

To save a new sound: 

• Drag the pointer to Save As and release. 

• If you have two drives, click Drive to change to the second disk drive. 
Make sure a formatted disk is loaded in the drive. 

• If you have one drive, remove the "Program" disk and insert a format
ted disk in the drive, then click Drive. 

• To place a new folder on the disk, click New Folder, then type a name 
for the folder in the Save As: box, and press Return. 

• To open a folder, click the folder name in the Sound List, then click 
Open. 

• Click the Save As: box. A cursor bar appears. 

• Type a name for the sound, up to 10 characters. Add the extension .SND 
to the name, and press Return. 
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To save a sound by a new natIle: 

IJ J o 

Dor-mc::z-vous, 

• Drag the pointer to Save As and release. 

I J o 

dor-mez-vous? 

• Press the Delete key several times to remove the previous name from 
the Save As: box 

• Type the new name (include the extension .SND), and press Return. 

Keep in mind that you can't save sounds to The Music Studio "Program" 
disk. Instead, you'll need to place a formatted disk with sufficient space 
for your sound in the disk drive. 

Revert 
Select Revert when you want to change a sound back to the version you 
last saved to disk. Revert clears any changes you've made with Design 
Instrument and loads the sound from disk. 

• Drag the pointer to Revert and release. 

• A dialog box appears: 

Discard recent changes? 

• Click OK to load the sound from disk. Click Cancel to keep the sound 
in the work area. 
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accent, 7, 40 
accessories menu, 8, 49 
accidentals, 7, 38, 41-42 
Add Lyrics, 56-57 
add repeat, 46 
Additional Songs and Instruments disk, 2, 9, 24 
ADSR graph, 23-27 
Append, 50 
Apple menu, 8, 49 
attack,23 

bass clef, see: lower staff 
block actions, 7, 15-16, 38,42-46 
block marker, 15, 37 
block selectors, 37 

Change Key Signature, 46 
change note stem direction, 57-58 
Change Song Title, 55 
change tempo, 47-48 
change volume, 48 
changing notes, 17-18 
column, 36-37 
command key, 38 
composition and editing tools, 6-7, 37-48 
connecting notes, see: tie 
copy block, 42, 43 
copying, 15-16 
creating instruments or voices, 24-25 
current column/measure, 36 

decay, 23 
deleting songs, 48, 53-54 
Design Instrument window, 24-25, 39, 55, 62 
disks, 2, 9, 24 
dot, 7, 38, 39, 40 
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dotted notes, 18, see also: dot 
duration, 42, 44, 45 

ear, 7, 49 
elements of sound, 23 
emphasis, 7, 38, 39-40 
erasing, 48 

File menu, 8, 50-54 
flats, see: accidentals 
Flip Note, 57-58 
flying note, 7, 49 

Goodies menu, 8, 49, 54-56 
grand staff, 6 

IFF, 59, 61 
insert block, 43 
Insert Measure Bars, 56 
inverting stems, see: Flip Note 

Jukebox, 10, 54 

key signature, 7, 38, 45, 46-47 

last column/measure, 37 
lengthen durations, 42, 44 
Load Song Files window, 9, 50-51 
Load Sound Files window, 59-60 
looking at a sound, 25-26 
lower staff, 6, 36 
lyrics, 56-57 

measure, 7, 36, 37, 38, 39, 56, 57 
Measure Numbers Off/On, 57 
Merge, 50 
message box, 7, 38 
MIDI-compatible instruments, 2, 3, 6, 21, 22 
MIDI input, 2 
MIDI interface, 2, 5,6,21-22 
MIDI output, 2, 58 
MIDI parameters, 21-22, 55, 58 
mouse actions, 3 . 
move block, 42, 43 
multi-track recorder, 29 
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naturals, see: accidentals 
note menu, 7, 38, 40-41 
note pointer, 41, 57 
notes 

changing, 14 
copying, 14 
dotted, 18 
deleting, 14, 41 
inverting stems, see: Flip Note 
placing, 13-14,40 

number measure bars, 56 

octave, 25 
Open (File menu), 50-51 
Open (Sounds menu), 59-62 
Options menu, 8, 49, 56-58 

Paintbox, 10-12, 55 
painting songs, 10-12 
placing notes, 13-14, 40 
playback tools, 7, 49 
playing songs, 10, 58 
Print Song, 54 
printing songs, 54 
Program disk, 2 

Quit, 54 
quitting the program, 54 

range, 25 
release, 23, 25 
real-time MIDI input, 2 
Remove Lyrics, 56-57 
RenamelDelete, 53-54 
repeat, 42, 46 
replace durations, 42, 44 
replace instrument, 42, 43-44 
rest, 7, 38, 41 
Revert (File menu), 53 
Revert (Sounds menu), 62 

sample songs, 2 
sample sounds, 23-24 
Save (File menu), 51 
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Save (Sounds menu), 60 
Save As (File menu), 51-53 
Save As (Sounds menu), 60-62 
saving 

MIDI parameters, 22 
songs, 16-17, 51-53 
sound files, 60-62 

selecting instruments, 7 
selectors, 6 
screen, 5, 35 
scroll handies, 19, 36 
scrolling, 19 
sharps, see: accidentals 
shorten durations, 42, 45 
.SNG,9 
song files, 9 
song scroll bar, 7, 36 
song slider, 36 
songs 

changing title, 55 
deleting, 53-54 
merging, 50 
playing, 10, 58 
printing, 54 
renaming, 53-54 

sound envelope, see: ADSR graph 
sound files, 2, 58-62 
sounds 

creating, 26-28 
loading, 58-60 
saving, 28, 61 

Sounds menu, 8, 49, 58-62 
staffs, 36 
starting The Music Studio, 5 
stereo channels, 25 
sustain, 23, 25 
synthesizers, 2, 3, 21, 22 

tempo, 7, 38,47-48 
The Music Studio 

program, 8 
screen, 5-6 
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tie, 7, 38, 39 
time signature, 7, 38, 47 
track controls, 30 
tracks, 29-32, 57 
transpose, 42, 45-46 
trash, 7, 48 
treble def, see: upper staff 
triplets, 7, 40 
Tum Note Off, 58 
Tum IIGS Off/Tum MIDI Off, 58 

upper staff, 6, 36 
Use 1 Instrument, 58 
Use Tracks, 57 
using the mouse, 3 

vibrato, 25 
voice palette, 7, 26, 38, 39 
volume, 7, 38, 48 

wave banks, 23-24 
waveform editor, 23, 24 
.WBNK,24 
work area, 6, 35-37 
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